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Submission Template for ACM Papers* 

Insert Your Subtitle Here 

First A. Author† 

First Department Name, First Institution/University Name, City, State, Country, email@email.com 

Second B. Author 

Second Department Name, Second Institution/University Name, City, State, Country, email@email.com 
* Place the footnote text for the title (if applicable) here.  

† Place the footnote text for the author (if applicable) here.  

ABSTRACT 

This submission template allows authors to submit their papers for review to an ACM Conference or 

Journal without any output design specifications incorporated at this point in the process. The ACM 

“Submission Template” is a single column MS-Word document that allows authors to type their content 

into the pre-existing set of paragraph formatting styles applied to the sample placeholder text here, or copy-

and-paste their text and then apply the respective paragraph styles (Windows: you can open the Styles task 

pane from the Home tab [it can also be opened with the keyboard shortcut Alt+Ctrl+Shift+S]; MAC16: 

you can access the Styles pane at the right of the Home toolbar.) Highlight a section that you want to 

designate with a certain style, and then select the appropriate style from the list. To view which style is 

being used in any part of this document, place your cursor on your text and look at the “Current style” field 

in the Styles pane. It is beneficial to create your document in draft mode with the style panel open in the 

left-side panel. If the panel is not immediately visible when the Submission Template is opened, you will 

need to open the panel manually—for Windows: click on the following from the main ribbon above: File > 

Options > Advanced > Display > Style area pane width in Draft and Outline views. Set the style area width 

(1–1.5" is a good starting value.); for MAC: go to the “View” menu and select “Draft”; then go to the 

“Word” menu and select “Preferences” and then “View,” under the “Window” section insert “1.5” inches 

under the style area width. If a paper is accepted for publication, authors will be instructed on the next 

steps: to submit a revised document file after applying the Word version of the ACM Master Article 

Template to their paper. Building on the work authors have already completed using this “Submission 

Template,” the ACM Master Article Template will contain macros, functionalities, and validations that 

need to be applied before a paper can be submitted for publication. Authors must then follow the 

submission instructions found on their respective publication’s web page. Once your submission is 

received, your paper will be processed to produce the formatted Word, PDF, and HTML5 output formats, 

which will be provided to you for review, revision/resubmission (if applicable), and approval.  

CCS CONCEPT insertion: The new template enables you to import required indexing concepts for your 

article from the ACM Computing Classification System (CCS) using an indexing support tool found in the 

ACM Digital Library (DL). The tool generates formatted text after you have selected your terms. To insert 

your CCS terms into your document, copy and paste the formatted text from the CCS tool using the 

“https://dl.acm.org/ccs/ccs.cfm” link into the “CCS CONCEPTS” section.  

An additional step is necessary to ensure that the proper CCS terms are added to the Digital Library citation 

page: from the “view CCS TeX Code” listing, click on “Show the XML Only.” Highlight and copy the 

XML code from the window. You must insert the XML code into your Word document’s properties: from 

your Word document, click on “File”, then click on the “Info” tab on the left-hand side panel, then click 

“Properties” and select “Show All Properties.” Click within the “Comments” metadata field and paste the 

XML data . 

CCS CONCEPTS 

http://www.acm.org/publications/class-2012
http://dl.acm.org/ccs/ccs.cfm?
https://dl.acm.org/ccs/ccs.cfm
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• Insert your first CCS term here • Insert your second CCS term here • Insert your third CCS term here 

KEYWORDS 

Insert comma delimited author-supplied keyword list, Keyword number 2, Keyword number 3, Keyword 

number 4 

1 Introduction: About this Template 
All style elements are specified in this template to facilitate the production of your paper and to have the 

styles consistent throughout. The paragraph styles are built-in and examples of the styles are provided 

throughout this document. Save as you go and backup your work regularly! 

1.1 More about the submission template 

This submission version of your paper should not have headers or footers, Baldassare (2000). It should 

remain in a one-column format—please do not alter any of the styles or margins.1 

1.1.1 How to apply Display Math. 

There are two types of math equations: the numbered display math equation and the un-numbered display 

math equation. Below are examples of both.2 
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The DisplayFormula style (above) is applied in the numbered math equation. A 

numbered display equation always has an equation number (label) on the right. 
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The DisplayFormulaUnnum style (above) is applied only in unnumbered equations. An 

unnumbered display equation never contains an equation number Bertot and Grimes 

(2012) on the right—this element distinguishes it from the numbered equation. Please 

note: the subsequent text after the DisplayFormula (numbered equation) or 

DisplayFormulaUnnum (unnumbered equation) must have the paragraph style 

ParaContinue applied. 

1.1.2 Figures and Tables. 

Figure(s) and table(s) are “float elements” which should be inserted after their first text reference, and have 

specific styles for identification. Insert a figure and apply the “Image” paragraph style to it. For the figure 

caption, apply the style “FigureCaption.” Below is an example of a figure and caption with the styles 

applied. 

 
1 Instructions for inserting the footnotes in Windows and Mac16 platform: Place the cursor in text where the footnote mark should be located, go to 

“References” tab, select “Insert Footnote” and enter the footnote text. Return to your place in the document by double-clicking on the footnote marker at 

the beginning of the note. 

2 Instructions for inserting the footnotes in Mac11 platform: Click at the end of the word where you want to insert the footnote. Click on the Insert menu. 

Now click on Footnotes. Microsoft Word shifts the document to the footnote area. Insert the footnote text in the provided pane. 
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Figure 1: Figure caption and image above the caption [in draft mode the image will not appear on the screen.] 

Authors can also insert a (Abdelghaffar, Kamel, and Duquenoy 2010) multi-part figure above a single 

caption. Every inserted figure must have the “Image” style applied. Below are instructions regarding how 

to insert a multi-part figure in your paper. 

(i) If the author wants to insert two multi-part images, they must draw a one row and one column 

table and insert the images one-by-one in the cells.  

(ii) If the author wants to insert three multi-part images, they must draw a one-row and three-

column table and insert the images one by one in all three cells. 

(iii) If the author wants to insert four multi-part images, they must draw a two-row and two-

column table and insert the images one-by-one in all four cells. (see the following example): 

  

 

 

Figure 2: The layout of multipart images should be as per the above example within the table.  

All images must have the “Image” style applied. 

The instruction list below describes the required steps authors need to follow in order to insert descriptive 

text for figures (alt-txt value) in MS Word 2013 and 2016: 

1. Insert a picture in the document. 

2. Right click on the inserted picture and select the Format Picture option. 

3. In the settings at the right side of the window, click on the “Layout & Properties” icon (3rd option).  

4. Expand Alt Txt option. 

5. In the “Title” and “Description” text boxes, type the text you want to represent the picture, and then 

click “Close.” 

NOTE: For additional information regarding how best to write alt text descriptions and why doing this 

is so important, please see: https://www.acm.org/publications/taps/word-template-workflow.  

Below are steps to insert the alt-txt value in MS Word 2010/2011 for Windows*: 

https://www.acm.org/publications/taps/word-template-workflow
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1. Insert a picture in the document. 

2. Right click on the inserted picture and select the Format Picture option. 

3. Select the Alt Txt option from the left-side panel options. 

4. In the “Title” and “Description” text boxes, type the text you want to represent the picture, and then 

click “Close.” 

* The Mac 2011 version 14.0.0 and later allows the option for inserting “alt-text.” In the MAC version 

of Word 2016, right-click on the image and select “Edit Alt Text” from the pop-up menu and then 

enter the description for the alt text.  

Authors can also insert (please see Table 1) tables by using the MS Word option (INSERT ->Table) as 

Abdelsalam, Reddick, Gamal, and Al-shaar (2013) per the required row and column size. Every table must 

have a caption (title) and it must have the “TableCaption” style applied. Please note that tables should not 

be supplied as image files, but if they are images they must have the “Image” style applied. After a paper is 

accepted for publication, apply the “table head” style by highlighting the respective row and apply the 

“TableHead” style found in the “Body Element” section of the ACM Master Article Template. 

Tables can be very difficult for screen reader users to understand unless they include markup that explicitly 

defines the relationships between all the parts (i.e.: headers and data cells). A key to making data tables 

accessible to screen reader users is to clearly identify column and row headers. For simple tables, the only 

step necessary for accessibility is to identify which row contains the column headers. Below are a few steps 

to help make tables accessible: 

1. Select that table’s row, then right-click the row and select “Table Properties”; 

2. In the Table Properties window, click the Row tab and select the box that says “Repeat as header row 

at the top of each page.” 

3. If every row contains the column header, then select “Table Properties” and follow the same process. 

Table 1: This is an example of the table caption. 

Table Head Table Head Table Head 

Row 1 Column 1 Row 1 Column 2 Row 1 Column 3 

Row 1 Column 1 Row 2 Column 2 Row 2 Column 3a 

a This is example of table footnote. 

1.2 How to Set a Figure (Image, Table, etc.) to Span Two Columns 

After your paper has been accepted, if there is a need for a figure to span both columns in the PDF/print 

output, please follow the steps below in your document to apply the “Large Float” style to the figure (which 

will be listed under the “Body Elements” menu after the ACM Master Article Template has been attached 

to your submission document): 

1) Apply both the “Image” and “FigureCaption” styles to the respective figure. 

2) After applying both styles, select both elements and apply the “Large Float” option  found under 

Body Elements -> Large Float as shown in the following screenshot: 
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Figure 3: Example of the “Large Float” feature. 

After completing these steps, the final layout generated by the production system’s conversion process will 

be rendered in the PDF/print output version as seen in the screenshot below. ACM recommends that you 

review the PDF proof of your text to ensure that your figure is properly formatted. 

 

Figure 4: Large figure spanning in both the columns in final version. 

1.2.1 Formatting math statements and extracts. 

Theorem/Proof/Lemma. Math statements should have the “Statement” style applied. This paragraph is 

an example of the “Statement” style. 
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“A clip, snippet, passage or extract from a larger work such as a news article, a film, a literary 

composition or other media is called the extract. An extract is a short passage taken from a text, 

film, or piece of music.” 

.... This is an example of a short Extract which is usually 1-2 lines of text. Please notice the 

placement of the ellipses and either end of the short extract... 

ALGORITHM 1: Iterative Algorithm 

current_position    center 

current_direction    up 

current_position  is inside circle 

while current_position is inside circle, do 

 neighborhood all grid hexes within two hexes from current_position 

 for each hex in neighborhood, do  

  for each neuron in hex do 

        convert neuron_orientation to vector 

        scale vector by neuron_excitation 

             vector_sum vector_sum + vector 

             end  

      end 

     normalize vector_sum 

end 

ACKNOWLEDGMENTS 

Acknowledgments are placed before the references. Add information about grants, awards, or other types 

of funding that you have received to support your research. Author can capture the grant sponsor 

information, by select the grant sponsor text and apply style ‘GrantSponser’. After this, select grant no and 

apply ‘GrantNumber’ from style panel. Example of Grant sponsor: Competitive Research Programme and 

example of Grant no: CRP 10-2012-03. 
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A  APPENDICES 

In the appendix section, three levels of Appendix headings are available. 

A.1 General Guidelines 

1. Save as you go and backup your file regularly. 

2. Do not work on files that are saved in a cloud directory. To avoid problems such as MS Word 

crashing, please only work on files that are saved locally on your machine. 

3. Equations should be created with the built-in Microsoft® Equation Editor included with your 

version of Word. (Please check the compatibility at http://tinyurl.com/lzny753 for using 

MathType.) 

4. Please save all files in DOCX format, as the DOC format is only supported for the Mac 2011 

version.  

5. Tables should be created with Word’s “Insert Table” tool and placed within your document. 

(Tables created with spaces or tabs will have problems being properly typeset. To ensure your 

table is published correctly, Word’s table tool must be used.) 

6. Do not copy-and-paste elements into the submission document from Excel such as charts and 

tables. 

7. Footnotes should be inserted using Word’s “Insert Footnote” feature. 

8. Do not use Word’s “Insert Shape” function to create diagrams, etc. 

9. Do not have references appear in a table/cells format as it will produce an error during the layout 

generation process. 

10. MS Word does not consistently allow the original formatting to be modified in the text. In these 

cases, it is best to copy all the document’s text from the specific file and paste into a new MS 

Word document and then save it. 

11. At times there are font problems such as “odd” stuff/junk characters that appear in the text, usually 

in the references. This can be caused by a variety of reasons such as copying-and-pasting from 

another file, file transfers, etc. Please review your text prior to submission to make sure it reads 

correctly. 

A.1.1 Preparing Graphics 

• Accepted image file formats: TIFF (.tif), JPEG (.jpg). 

• Application files (e.g., Corel Draw, MS Word, MS Excel, PPT, etc.) are NOT recommended. 

• Images created in Microsoft Word using text-box, shapes, clip-art are NOT recommended. 

• Scalable vector formats (i.e., SVG, EPS and PS) are greatly preferred.  

• IMPORTANT: All fonts must be embedded in your figure files. 

• Set the correct orientation for each graphics file. 

 

 

http://tinyurl.com/lzny753

